How to download your family from FamilySearch to Legacy

To prepare Legacy to integrate with FamilySearch Family Tree
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1. Start Legacy. It will usually start up with the last file upon which you worked. In fact
you can read that file name beside the title word “Legacy” at the very top of your
program. (See 1. File name here)

2. Next determine if you have the FamilySearch options turned on in your existing Legacy
program. Legacy can have an open family file in it while you do this OR you can close
the file by following #1 in the next section called “How to download your family from
FSFT with Legacy”

3. If you have the FamilySearch icon, then it is on. If not, click the Options tab across the

top of Legacy. \
o & ;.‘gug&fﬁ\' - Legacy - [C:\Users\GRA\Documents\Legi?' Family Tree\Data\FeezGerold—MF032003.fdb]
m File Edit Add View Repk‘ Tools

PERA AT IICODHO QG U

Startup Back Name Marriage Add Search Search Family To-Do Report Calendar Last Merge Internet Map Create Research Exit
Family List List Person~ Results Search List Menu Report v v Family CD Guidance Legacy

Shortcut Toolbar

[Famity Pedigree Descendant Chronaogy ndex |

‘ ‘Parents ‘ ’ Parents

Search Internet My Toolbar | Options Help

4. Once looking at the icons in the Options tab, click Customize.
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6. OPTIONAL: If you have an LDS account, also click 1.9 LDS (gbl) Display LDS
Information
7. Click Save

How to download your family from FamilySearch Family Tree with Legacy
1. Legacy is not empty if you see names in the family or pedigree views. If you want to
make a new file of just what is on FamilySearch, you need to close the existing family
file which Legacy is reading. Look for a gray “x” below the Close Program button
(usually the close program button is red when you hover over it and it has a white “x”
in the upper right corner of your screen). Click down and hold the gray “x* and notice
that it turns orange and is identified as a “Close Window”
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2. When you unclick the Close Window “x”, Legacy turns off the previously opened file
(which is already saved where you last used it). Now you have an empty file space in

which to import your FamilySearch file. If you have a GEDCOM file from another
program, here is where you can import it into Legacy.
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e program is now indicating which icons are found in the "File" tab. Select the icon
New File.
The "What would you like to do?" screen opens. It asks if you want to open one of the
Legacy files you have already started. You do not, so go to Other Choices:

@ Legacy Guided Startup Wizard |

2 |

- What would you like to do?

Please select one of the following choices:

Here are the names of some family files you have recently used. If you
would like to open one of these, just click the name.
FeezGeroldMF032003
Clifford17Feb2016dwnload_FS
12Feb2016DaviesLegacy

Other Choices:
( Start a New Family File...

Choose a Legacy File to Open... ]

[ Import From Another Program... Open the SAMPLE file ]

[ Download my family from FamilySearch

View the "What's New" help topic
View the "Getting Started” help topic

To learn more about what Legacy can do for you, watci\the video.
(Requires Internet access.)

Watch Legacy Tour '

| Exit Setup |

\

5. Click on the option Download my family from FamilySearch.
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How Do You Want to Start?

Please select one of the following choices:

(@ | want to sign into FamilySearch to download whst the Church has about me and my
~ fancestors.

Since this is a new blank start
up, click

I want to sign into
FamilySearch to download
what the Church has about
me and my ancestors.

(@) 1want to start by entering what | know

Click Next step.

7. Next Legacy wants
you to Enter a Name for the
New Family File, and it will
try to save it wherever you
have other Legacy files. You
can direct the window to go
to a different file on your
computer or to a thumb drive.
Give the file a name such as: Clifford17Feb2016dwnload_FS. Legacy will add the file
extension *.fdb when you finish. Click the Save button.

To learn more about what Legacy can do for you, watch the Walich 1 sgaoy Toss
video. (Requires Internet acoess.)

[ < Previous Step ] [ Nextstep>> |

@ Enter a Name for the New Far

Organize v New folder 4= v @

» GRA » MyDocuments » Legacy Family Tree » Data

G i -
9 Libraries Name Date modified Type Size

@il Bluehost )
= 0] FeezGeroldMF032003.fdb 2/17/20169:59PM  Legacy Genealogy... 12,404 KB

8] LUCHLE~2.fdb 3/31/20141211 PM  Legacy Genealogy... 3,396 kB
@ samplefdb 1/22/20159:23PM  Legacy Genealogy... 2,356 KB
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8. The Legacy program will locate the FamilySearch icon so it would appear among the
Legacy icons.

9. Several windows open and other file names will appear such as: System File Edit
View... so you will see several icons. If when you customized the Legacy program,
you placed the most used icons under the file called My Toolbar, you will find the
FamilySearch icon there. A FamilySearch Login window opens and asks for you to
Sign in here.
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10. Enter your FamilySearch User  FamilySearch Login  SSSSE )

name and Password——

I JJ Please login into FamilySearch I
If you do not have a user name
and password, click the link Sign in here I
"Click here to register at

’ Username
FamilySearch" and after you g ]
register, you return to the Forgot?
: : : Password
FamilySearch Login window - 1
screen and sign in. : |
Forgot?
[~ Save user name and password
[V Automatically login to FamilySearch
| Register here
Click here to register at FamilySearch.
After you have registered, return to this screen to sign in.
Proxy Settings
Prw: on
Click Login.
| Login I | Cancel |

11. If you have entered yourself, it will start with you and go back the number of generations
ut in the Options window. | put in 4 generations of ancestors. 1 Descendant
genekation is enough because only deceased people are shown. Check the box to Assign
sourcecitations to imported data. Check the option to Include spouses of childrgn if

Orgiveita Legacy FamiySearch
FamilySearch
Family Tree ID
number to start I\ siating persan Options
withand then || . vourserr(o = kwos-s1v)

click the Verify

button to be [v| Assign source citations to imported data

sure it is the [v] Include spouses of children
person yOU | Check for duplicates (This will slow down importing)
think it ShOU'd || Include Temple Ordinances

be.

{ | ) Import Individuals from FamilySearch

\ 4§‘ Generations

. r cendants \ 1i| Generations
FamilySearch ID ' \ Verify e

Click OK.

%} oK || cancel
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12. Give it time to download everyone. It needs to make several swipes over the
information. | did 4 generations with all citations and spouses of children and it took
10 minutes with high speed Google Internet. The file contained: People 361
Families 206. The family number is large because | included spouses for children.

13. Legacy asks you permission to "Refresh.” Clicking OK that it is fine to "Refresh."

Message .

i Message

0 Click OK to refresh Legacy after the new FamilySearch download is complete

14. Now you can see all the people in the program. Since the children for the first person
selected were alive they were not included in the Descendant download. When
Legacy finished "refreshing” (less than 10 seconds), notice how the sources were
imported, the back and forth arrows indicating it matches what is on FSFT, and the red
circle with an exclamation point signifying something needs fixing.

Husband [M]2]3]4a]5]6]7]8]9]
. William SMITH [327]

e

Born 12 Nov 1841, Steeple Ashton, Wiltshire, Englan
Chr 19 Dec 1841, Steeple Ashton, Wiltshire, Englan
Died 10 Oct 1901, Millcreek, Salt Lake, Utah, United

Buried 12 Oct 1901, Elysian Gardens, Salt Lake City,
FSID KWNT-C8H

[ AP E E ¥ B2 A

Click the Source icon to see details brought over from FSFT. This is the Events icon.
The Assigned Sources brought over from FSFT as shown on the next page, were all
identical except in cases where a researcher put in extra information. They merely
indicated the source is available at FamilySearch.Yet the original sources shown in FSFT
(and illustrated at the bottom of the next page) contained much more information. FSFT
did, however, give a different format of the data for a Footnote or endnote citation, a
Subsequent Citation, and a Bibliography. Considering the much better way in which
Legacy keeps notes, | wouldn’t bother downloading source notes at this time.
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Assigned Sources

Events | Source List Name | Detail |V al | Close |
Name *FamilySearch Family Tree (http://ww w.familysear Wiliam, Smith| []
Birth |FamiySearch Famiy Tres (Wipdiwww.familysear|Wilam, Smih| 1
Christening *FamilySearch Family Tree (http://w w w.familysear Wiliam, Smith (]
Death |*FamiySearch Famiy Tree (http://www.familysear Wiliam, Smith| (]

Zoom

Never Marrie Add a New Source...

Cdnilad Chmi,

Unspecified Show all Events

Burial *FamilySearch Family Tree (http://www.familysear
Research
.

@ Show Entire Source () Show Source using Print Options

FootnoteEndnote Citation:

The Church of Jesus Christ of Latter-day Saints, "FamilySearch Family Tree," database, FamilvSearch
(http://www.familysearch.org : accessed 17 Fzb 2016), entry for William Smith, person ID KWNT-CSH.
Subsequent Citation:

[3 The Church of Jesus Christ of Latter-day Saints, "FamilySearch Family Tree," database entry for William
Smith, person ID KWNT-CSH.
Bibliography:
The Church of Jzsus Christ of Latter-day Saints. "FamilySearch Family Tre= " Database. FamilvSearch. 2=

¥ Sources

Open Details | Create a New Source | @ Attach from Source Box

& William Smith in entry for Louisa Dufossee Smith Gater, "Utah Death Certificates,
1904-1964"

g William Smith, "United States Census, 1880"

¥ Wm in entry for Willm Dufosse Smith, "Utah Deaths and Burials, 1888-1946"

. Wm in entry for Willm Dufosse Smith, "Utah, Salt Lake County Death Records,
1849-1949"

& William Smith in entry for Alice Sophia Dufosee Smith Park, "Utah Death
Certificates, 1904-1964"

Wnm. Smith in entry for Hannah Dufosee Blake, "Utah Death Certificates, 1904-
1964"

& Legacy NFS Source: WILLIAM SMITH - Individual or family possessions: birth: 12
November 1841; England

& Legacy NFS Source: WILLIAM SMITH - Published information: Utah pioneers:
arrived in 1862;

& William Smith, "England Marriages, 1538-1973 "
g% William Smith, "England Births and Christenings, 1538-1975"
& William Smith, "United States Census, 1900"

g% William Smith, "England Births and Christenings, 1538-1975"



15. However, the Events set the stage to use the Research Guidance program in Legacy

to help you determine what to do next.

6 Research Guidance Results for William

The timeline helps Legacy find the best sources to

William SMITH [327]

e
Edit Options Help Close

b. |12 Nov 1841, Steeple Ashton, Wittshire, England

d. :[10 Oct 1901, Millcreek, Salt Lake, Utah, United States

@ Review Timeline | € Freliminary Survey (44) I €) suogestes Sources (108) ' © oot |
Purpose 11 Timeline Events
Use Name Date Place -

achieve your goals. Christened 19 Dec 1841 Steeple Ashton, Wiltshire, England
'Marriage 23 Apr 1862 Salisbury, Wiltshire, England
What should be included in the Child 9 Sep 1863 Parleys Canyon, Salt Lake, Utah
timeline? |Child '5Jan 1866  Millcreek, Salt Lake, Utah
Answer: anything that can identify William SMITH [327] .Child 13 Feb 1868 Mﬁllcreek, Salt Lake, Utah, Un?ted St
in a location on a specific date. Suggested timeline Child 10 Apr 1870 Millcreek, Salt Lake, Utah, United St
events include: census, deeds, directories, military, Child 24 Mar 1874 Mill Creek, Salt Lake, Utah
travel, etc. Child 11 Dec 1877 Millcreek, Salt Lake, Utah
Death 10 Oct 1901 Millcreek, Salt Lake, Utah, United St
‘Burial 112 0ct 1901 Elysian Gardens, Salt Lake City, Sal

Birth |12 Nov 1841 | Steeple Ashton, Wiltshire, England il

v

Event details:

Unselect All

Click here for an example of a completed timeline [ ||| Add EventFact

] [ | Edit Event/Fact

Husband [1]2]3]4]5]6]7]8]9]

Born
Chr
Died
Buried
FSID
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William SMITH [327] {BCIEPSC}

vl

12 Nov 1841, Steeple Ashton, Wiltshire, Englan
19 Dec 1841, Steeple Ashton, Wiltshire, Englan
10 Oct 1901, Millcreek, Salt Lake, Utah, United
12 Oct 1901, Elysian Gardens, Salt Lake City,

KWNT-C8H

B e e 32 mad

Look at an LDS view of the
same person. It has back
and forth arrows to indicate
it matched up with FSFT,
and letters across the top
after the Record 1D number
of work completed. It also
has a red circle with an
exclamation point signifying
something needs fixing.



| Legacy Home ' Family | Pedigree 'Descendant ' Chronology 'Index

4 3]

*

Orville Sutherland COX [68]
(1814-1888) {BCIEPSCc}

Delaun Mills COX [22]
(1850-1932) {BCIEPSC}

¢

Elvira Pamela MILLS [69]
(1820-1903) {BCIEPSC}

Charles Robert COX [5]

(1880-1955) {BCIEPSC}

¢

Robert H. BROWN [172]
(1832-1877) {BCIEPsc}

Susan BROWN [23]
(1862-1936) {BCIEPSC}

Eunice PECTOL [173]

o
Tags ' (1834-1913) {BCIEPSC}
I [1]2]3]4]5]6][7]8 e
M([1]2]3]4]5]6]7]8

(]
Jonathan Upham COX Sr [125]
(1785-1830) {BCIE SC}
214
(1]
Lucinda BLOOD [126]
(1787-1838) {BCIE SC}
S
Robert Fredrerick MILLS [168]
(1792-1827) {BCIE SC}
214
Rhoda HULET [169]
(1795-1837) {BCIE SC}
214
(1]
James Polly BROWN [214]
(1803-1871) {BCIE SC}
214
Eunice REASOR [215]
(1808-1858) {BCIE SC}
S
(1]
George PECTOL [249]
(1805-1869) {BCIE SC}
=ik
(1]
Sarah REASOR [250]
(1810-1861) {BCIE SC}
S

16. This is a pedigree view. If you see a red button with a white ! in the middle of it, that

is notification that something needs fixing on that person or family. Again the back

and forth arrows indicate that it matches what is on FSFT at the time it was

downloaded.
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